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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP Compaq 6515b
Notebook PC
without WWAN

HP Compaq 6515b
Notebook PC with
WWAN

Processors AMD Turion™ 64 Mobile Technology
processors:

● TL-64 (dual-core) 2.2-GHz (1 MB of L2 cache)

● MK-38 (single-core) 2.2-GHz (512 KB of L2
cache)

● TL-60 (dual-core) 2.0-GHz (1 MB of L2 cache)

● TL-56 (dual-core) 1.8-GHz (1 MB of L2 cache)

● TL-52 (dual-core) 1.6-GHz (1 MB of L2 cache)

● TL-50 (dual-core) 1.6-GHz (1 MB of L2 cache)

√ √

 Mobile AMD Sempron™ processors:

● 3800+ 2.2-GHz (256 KB of L2 cache)

● 3600+ 2.0-GHz (256 KB of L2 cache)

● 3500+ 1.8-GHz (512 KB of L2 cache)

● 3400+ 1.8-GHz (256 KB of L2 cache)

√ √

Chipsets ● Northbridge: RS690T

● Southbridge: SB600

√ √

Graphics Unified Memory Architecture (UMA), integrated with
shared video memory

√ √

Panels ● 14.1-inch, WXGA with WWAN and WLAN
antenna transceivers and cables

 √

 ● 14.1-inch, WXGA, BrightView with WLAN
antenna transceivers and cables

√  

 ● 14.1-inch, WXGA, with WLAN antenna
transceivers and cables

√  

 ● Support privacy film √ √

Memory ● Two SODIMM slots, both customer accessible/
upgradable (memory slot under the keyboard
must be populated first)

● DDRII PC2-5300 (667-MHz)

√ √
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Category Description HP Compaq 6515b
Notebook PC
without WWAN

HP Compaq 6515b
Notebook PC with
WWAN

● Supports dual-channel memory

● Supports the following configurations:

◦ 4096 MB total system memory (2048 MB
× 2, dual-channel)

◦ 2048 MB total system memory (2048 MB
× 1)

◦ 2048 MB total system memory (1024 MB
× 2, dual-channel)

◦ 1024 MB total system memory (512 MB ×
2, dual-channel)

◦ 1024 MB total system memory (1024 MB
× 1)

◦ 512 MB total system memory (512 MB ×
1)

Hard drives ● Supports all 9.5-mm, 2.5-inch hard drives

● Serial ATA

● The following hard drives are available:

◦ 160-GB, 5400-rpm

◦ 120-GB, 5400-rpm

◦ 80-GB, 7200- and 5400-rpm

√ √

Optical drives ● 12.7-mm tray load

● Fixed, no modular requirements (1 screw
removal)

● Supports all common optical formats including
the following:

◦ DVD±RW and CD-RW Super Multi Double-
Layer Combo Drive with Lightscribe

◦ DVD±RW and CD-RW Super Multi Double-
Layer Combo Drive

◦ DVD/CD-RW Combo Drive

◦ DVD-ROM drive

√ √

Diskette drive Supports external USB drive only √ √

Audio ● Azalia

● Stereo speakers

● Integrated monoaural microphone

● Headphone and microphone jacks

√ √
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Category Description HP Compaq 6515b
Notebook PC
without WWAN

HP Compaq 6515b
Notebook PC with
WWAN

Modem ● 56K data/fax modem (MDC1.5)

● Modem cable included in Brazil, the Czech
Republic, France, Greece, Hungary, Israel, Latin
America, Poland, Russia, Saudi Arabia,
Slovakia, Slovenia, South Africa, Turkey, and
the United Kingdom.

√ √

Ethernet ● Integrated Broadcom 5787 10/100/1000
LAN

● S4/S5 wake on LAN (on AC power only)

● Network interface card (NIC) power down

√ √

Wireless Integrated wireless options by way of wireless module

 Wireless local area network (WLAN)
options:

  

 ● 802.11a/b/g/n √ √

 ● 802.11a/b/g √ √

 ● 802.11b/g √ √

 ● Option for no WLAN √  

 Wireless wide area network (WWAN)
options:

  

 ● Evolution-data optimized (EVDO) WWAN
module

 √

 ● High-speed downlink packet access (HSPDA)
WWAN module

 √

 ● Subscriber identity module (SIM)  √

 Wireless personal area network (WPAN)
options:

● Bluetooth® 2.0 module + Blueflame module

● Supports no WPAN option

√ √

External media
card

● One Type I/II PC Card slot, 16-bit PCMCIA and
32-bit CardBus

● Media Card Reader (MS Duo adapters, plus SD,
MMC, MS, MSPro, and xD)

√ √

Ports ● 1394a port

● Docking connector

● Headphone connector

● Microphone connector

● Primary battery connector

● RJ-11 modem port

√ √
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Category Description HP Compaq 6515b
Notebook PC
without WWAN

HP Compaq 6515b
Notebook PC with
WWAN

● RJ-45 Ethernet port

● S-Video-out connector

● Smart AC adaptor connector

● Travel battery connector

● USB ports (4)

● VGA port (Dsub 15-pin) supporting 1600 ×
1200 external resolution @ 75 Hz, hot plug/
unplug, and auto detect

Docking Docking support √ √

Keyboard/
pointing devices

● Spill-resistant keyboard with embedded numeric
keypad, TouchPad, and fingerprint reader

● Two-way scrolling

● Windows Vista™ hardware Start button

√ √

Power
requirements

Primary batteries:

● 6-cell, 2.55-Ah Li-ion battery (55-Wh)

● 6-cell, 2.20-Ah Li-ion battery (47-Wh)

Travel batteries:

● 12-cell Li-ion battery

● 8-cell Li-ion battery

AC adapter:

● 90-watt

● Localized cable plug support

● 3-wire plug with ground pin

● Supports multipin AC connector)

√ √

Security ● Fingerprint reader

● HP 3D DriveGuard

● Security cable slot

● Smart card reader/bezel snap in

● Trusted platform module (TPM) 1.2 on system
board

√ √

Operating system Preinstalled:

● Windows Vista Home Basic

● Windows Vista Business 32/64

√ √

4 Chapter 1   Product description ENWW



Category Description HP Compaq 6515b
Notebook PC
without WWAN

HP Compaq 6515b
Notebook PC with
WWAN

● FreeDOS

● Windows® XP Professional

Certified: SuSe Linux Enterprise Desktop (SLED) 10

Supported: Windows Vista Enterprise

Serviceability End-user replaceable parts:

● AC adapter

● Hard drive

● Memory module

● Optical drive

● Primary battery

● WLAN module

● WWAN module

√ √

Category Description HP Compaq 6510b
Notebook PC
without WWAN

HP Compaq 6510b
Notebook PC with
WWAN

Processors Intel® Core® Duo processors:

● T7700 2.4-GHz processor with 800-MHz Front
Side Bus (FSB) and 4 MB of L2 cache

● T7500 2.2-GHz processor with 800-MHz FSB
and 4 MB of L2 cache

● T7300 2.0-GHz processor with 800-MHz FSB
and 4 MB of L2 cache

● T7100 1.8-GHz processor with 800-MHz FSB
and 2 MB of L2 cache

√ √

Chipset ● Northbridge: Intel GM965 with 800-MHz FSB

● Southbridge: ICH8M

√ √

Graphics Unified Memory Architecture (UMA), integrated with
shared video memory

√ √

Panels ● 14.1-inch, WXGA with WLAN and WWAN
antenna transceivers and cables

 √

 ● 14.1-inch, BrightView, WXGA with WLAN
antenna transceivers and cables

√  

 ● 14.1-inch, WXGA with WLAN antenna
transceivers and cables

√  

 ● Support privacy film √ √
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Category Description HP Compaq 6510b
Notebook PC
without WWAN

HP Compaq 6510b
Notebook PC with
WWAN

Memory ● Two SODIMM slots, both customer accessible/
upgradable (memory slot under the keyboard
must be populated first)

● DDRII PC2-5300 (667-MHz)

● Supports dual-channel memory

● Supports the following configurations:

◦ 4096 MB total system memory (2048 MB
× 2, dual-channel)

◦ 2048 MB total system memory (2048 MB
× 1)

◦ 2048 MB total system memory (1024 MB
× 2, dual-channel)

◦ 1024 MB total system memory (512 MB ×
2, dual-channel)

◦ 1024 MB total system memory (1024 MB
× 1)

◦ 512 MB total system memory (512 MB ×
1)

√ √

Hard drives ● Supports all 9.5-mm, 2.5-inch hard drives

● Serial ATA

● The following hard drives are available:

◦ 160-GB, 5400-rpm

◦ 120-GB, 5400-rpm

◦ 80-GB, 7200- and 5400-rpm

√ √

Optical drives ● 12.7-mm tray load

● Fixed, no modular requirements (1 screw
removal)

● Supports all common optical formats including
the following:

◦ DVD±RW and CD-RW Super Multi
Double-Layer Combo Drive with
Lightscribe

◦ DVD±RW and CD-RW Super Multi
Double-Layer Combo Drive

◦ DVD/CD-RW Combo Drive

◦ DVD-ROM drive

√ √

Diskette drive Supports external USB drive only √ √
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Category Description HP Compaq 6510b
Notebook PC
without WWAN

HP Compaq 6510b
Notebook PC with
WWAN

Audio ● Azalia

● Stereo speakers

● Integrated monoaural microphone

● Headphone and microphone jacks

√ √

Modem ● 56K data/fax modem (MDC1.5)

● Modem cable included in Brazil, the Czech
Republic, France, Greece, Hungary, Israel,
Latin America, Poland, Russia, Saudi Arabia,
Slovakia, Slovenia, South Africa, Turkey, and
the United Kingdom.

√ √

Ethernet ● Integrated Broadcom 5787 10/100/1000
LAN

● S4/S5 wake on LAN (on AC power only)

● Network interface card (NIC) power down

√ √

Wireless Integrated wireless options by way of wireless module

 Wireless local area network (WLAN)
options:

  

 ● 802.11a/b/g/n √ √

 ● 802.11a/b/g √ √

 ● 802.11b/g √ √

 ● Option for no WLAN √  

 Wireless wide area network (WWAN)
options:

  

 ● Evolution-data optimized (EVDO) WWAN
module

 √

 ● High-speed downlink packet access (HSPDA)
WWAN module

 √

 ● Subscriber identity module (SIM)  √

 Wireless personal area network (WPAN)
options:

● Bluetooth® 2.0 module + Blueflame module

● Supports no WPAN option

√ √

External media
card

● One Type I/II PC Card slot, 16-bit PCMCIA and
32-bit CardBus

● Media Card Reader (MS Duo adapters, plus
SD, MMC, MS, MSPro, and xD)

√ √

Ports ● 1394a port

● Docking connector

√ √
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Category Description HP Compaq 6510b
Notebook PC
without WWAN

HP Compaq 6510b
Notebook PC with
WWAN

● Headphone connector

● Microphone connector

● Primary battery connector

● RJ-11 modem port

● RJ-45 Ethernet port

● S-Video-out connector

● Smart AC adaptor connector

● Travel battery connector

● USB ports (4)

● VGA port (Dsub 15-pin) supporting 1600 ×
1200 external resolution @ 75 Hz, hot plug/
unplug, and auto detect

Docking Docking support √ √

Keyboard/
pointing devices

● Spill-resistant keyboard with embedded numeric
keypad, TouchPad, and fingerprint reader

● Two-way scrolling

● Windows Vista™ hardware Start button

√ √

Power
requirements

Primary batteries:

● 6-cell, 2.55-Ah Li-ion battery (55 Whr)

● 6-cell, 2.20-Ah Li-ion battery (47 Whr)

Travel batteries:

● 12-cell Li-ion battery

● 8-cell Li-ion battery

AC adapter:

● 90-watt

● Localized cable plug support

● 3-wire plug with ground pin

● Supports multipin AC connector

√ √

Security ● Fingerprint reader

● HP 3D DriveGuard

● HP DriveGuard

● Security cable slot

√ √

8 Chapter 1   Product description ENWW



Category Description HP Compaq 6510b
Notebook PC
without WWAN

HP Compaq 6510b
Notebook PC with
WWAN

● Smart card reader/bezel snap in

● Trusted platform module (TPM) 1.2 on system
board

Operating system Preinstalled:

● Windows Vista Home Basic

● Windows Vista Business 32/64

● FreeDOS

● Windows® XP Professional

Certified: SuSe Linux Enterprise Desktop (SLED) 10

Supported: Windows Vista Enterprise

√ √

Serviceability End-user replaceable parts:

● AC adapter

● Hard drive

● Memory module

● Optical drive

● Primary battery

● WLAN module

● WWAN module

√ √
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2 External component identification

Top components
Buttons, switches, and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista) or
in Standby (Windows XP), press the button briefly to exit
Sleep or Standby.

● When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.
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Item Component Function

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) Info button (select models only) Launches Info Center, which enables you to open various software
solutions.

(4) Wireless button Turns the wireless feature on or off, but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to establish
a wireless connection.

(5) Presentation button (select models only) Starts the presentation feature.

(6) Volume mute button (select models only) Mutes and restores speaker sound.

(7) Volume scroll zone (select models only) Adjusts speaker volume. Slide your finger to the left to decrease
volume and to the right to increase volume. You can also tap the
minus sign on the scroll zone to decrease volume, or tap the plus
sign on the scroll zone to increase volume.

(8) Internal microphone (select models only) Records sound.

(9) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a password
logon.
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Lights

Item Component Function

(1) Power lights (2) ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power rating
should be connected.

● Off: The computer is off or in Hibernation.

(2) Wireless lights (2) ● On: An integrated wireless device, such as a wireless local
area network (WLAN) device, a wireless wide-area network
(WWAN) device, and/or a Bluetooth device is turned on.

● Off: All wireless devices are turned off.

(3) Caps lock light On: Caps lock is on.

(4) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

(5) Volume mute light (select models only) ● Off: Computer sound is turned on.

● On: Computer sound is turned off.

(6) Volume down light (select models only) Blinking: The volume scroll zone is being used to decrease speaker
volume.

(7) Volume up light (select models only) Blinking: The volume scroll zone is being used to increase speaker
volume.

(8) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
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Item Component Function

reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(9) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse
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Front components

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a WLAN device,
a WWAN device, and/or a Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power rating
should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Display release latch Opens the computer.

(6) Speakers Produce sound.
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Left-side components

Item Component Function

(1) PC Card slot Supports optional Type I or Type II 32–bit (CardBus) or 16–bit PC
Cards.

(2) PC Card eject button Ejects a PC Card from the PC Card slot.

(3) Power connector Connects an AC adapter.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) USB ports (2) Connect optional USB devices.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

(7) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(8) 1394 port (select models only) Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.
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Rear components

Item Component Function

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) RJ-45 (network) jack Connects a network cable.

(3) External monitor port Connects an external VGA monitor or projector.

(4) S-Video-out jack Connects an optional S-Video device such as a television, VCR,
camcorder, overhead projector, or video capture card.

Right-side components

Item Component Function

(1) Media Card Reader (select models only) ● Secure Digital (SD) Memory Card

● MultiMediaCard (MMC)

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● Memory Stick Duo Adapter

● xD-Picture Card (XD)

(2) USB ports (2) (select models only) Connect optional USB devices.

(3) Optical drive Reads optical discs, and, on select models, also writes to optical
discs.

(4) RJ-11 (modem) jack Connects a modem cable.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches Releases the battery from the battery bay.

(3) Accessory battery connector Connects an optional accessory battery.

(4) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) Bluetooth module compartment (select models only) Contains a Bluetooth device.

(6) Docking connector (select models only) Connects an optional docking device.

(7) Memory/WLAN module compartment Contains the memory module slot and the WLAN module slot.

CAUTION: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support through
Help and Support.

(8) Hard drive bay Holds the hard drive.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Item Description Spare part number

(1) Display assemblies 

 14.1-inch, WXGA display assembly for use only with HP Compaq 6515b computer models
with WWAN capability

443895-001

 14.1-inch, WXGA, BrightView display assembly for use only with HP Compaq 6515b
computer models without WWAN capability

443894-001

 14.1-inch, WXGA display assembly for use only with HP Compaq 6515b computer models
without WWAN capability

443893-001

 14.1-inch, WXGA display assembly for use with HP Compaq 6510b computer models with
WWAN capability

449823-001

 14.1-inch, WXGA display assembly for use with HP Compaq 6510b computer models
without WWAN capability

449822-001

 Display assembly internal components

 Display bezel 447205-001

 14.1-inch, WXGA display panel for use with computer models with WWAN capability 446916-001

 14.1-inch, WXGA display panel for use with computer models without WWAN capability 446914-001

 14.1-inch, WXGA, BrightView display panel for use with computer models without WWAN
capability

446915-001

 Display inverter (includes 2-sided tape) 446870-001

 Display left and right hinges 447204-001

 Display enclosure 450067-001

(2) Switch cover (includes power button board and cable and LED board and cable) 447203-001

(3) Keyboards

 Belgium 443922-181

 Brazil 443922-201

 The Czech Republic 443922-221

 Denmark 443922-081

 France 443922-051

 French Canada 443922-121

 Germany 443922-041

 Greece 443922-DJ1

 Hungary 443922-211

 Iceland 443922-DD1

 International 443922-A41

 Israel 443922-BB1

 Italy 443922-061

 Japan 443922-291

 Korea 443922-AD1
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Item Description Spare part number

 Latin America 443922-161

 The Netherlands 443922-B31

 Norway 443922-091

 Portugal 443922-131

 Russia 443922-251

 Saudi Arabia 443922-171

 Slovakia 443922-231

 Slovenia 443922-BA1

 Spain 443922-071

 Sweden 443922-B71

 Switzerland 443922-BG1

 Taiwan 443922-AB1

 Thailand 443922-281

 Turkey 443922-141

 The United Kingdom 443922-031

 The United States 443922-001

(4) Fan 443917-001

(5) WWAN modules

 EVDO WWAN module for use in all countries and regions except Japan and Asia/Pacific 399440-001

 Vodafone HSPDA WWAN module 448672-002

 Cingular HSPDA WWAN module 448673-002

(6) Heat sinks (include thermal material)

 For use with HP Compaq 6515b computer models 443912-001

 For use with HP Compaq 6510b computer models 446920-001

 Thermal Material Kits (not illustrated)

 For use in all countries and regions except Japan and Asia/Pacific 413706-001

 For use Japan and Asia/Pacific countries and regions 445853-001

(7) Memory modules (667-MHz, PC2-5300, 1-DIMM)

 2048-MB 417506-001

 1024-MB 414046-001

 512-MB 414045-001

 Cable Kit (see Cable Kit on page 31 for more Cable Kit spare part information): 443887-001

(8a) Microphone (includes receiver and cable)

(8b) Modem module cable (includes RJ-11 connector and cable)
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Item Description Spare part number

(8c) Bluetooth module cable

 Plastics Kit (see Plastics Kit on page 30 for more Plastics Kit spare part information): 443905-001

(9a) PC Card slot bezel

(9b) Hard drive cover (includes 2 captive screws, secured by C-clips)

(9c) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(9d) Bluetooth module compartment cover (includes 1 captive screw, secured by a C-clip)

 Display bezel rubber screw covers (6 covers in 2 sizes; not illustrated)

 Base enclosure rubber screw covers (2 covers; not illustrated)

 Computer feet (8 feet in 2 sizes; not illustrated)

(10) Processors (include thermal material)

 Processors for use with HP Compaq 6515b computer models in all countries and regions except Japan and Asia/Pacific:

 ● AMD Turion TL-64 (2.2-GHz, 1 MB of L2 cache) 443913-001

 ● AMD Turion MK-38 (2.2-GHz, 512 KB of L2 cache) 446045-001

 ● AMD Turion TL-60 (2.0-GHz, 1 MB of L2 cache) 430876-001

 ● AMD Turion TL-56 (1.8-GHz, 1 MB of L2 cache) 430875-001

 ● AMD Turion TL-52 (1.6-GHz, 1 MB of L2 cache) 430874-001

 ● AMD Turion TL-50 (1.6-GHz, 1 MB of L2 cache) 450940-001

 ● Mobile AMD Sempron 3800+ (2.2-GHz, 256 KB of L2 cache) 450939-001

 ● Mobile AMD Sempron 3600+ (2.0-GHz, 256 KB of L2 cache) 443916-001

 ● Mobile AMD Sempron 3500+ (1.8-GHz, 512 KB of L2 cache) 430872-001

 ● Mobile AMD Sempron 3400+ (1.8-GHz, 256 KB of L2 cache) 430871-001

 Processors for use with HP Compaq 6515b computer models in Japan and Asia/Pacific countries and regions:

 ● AMD Turion TL-60 (2.0-GHz, 1 MB of L2 cache) 443892-001

 ● AMD Turion TL-56 (1.8-GHz, 1 MB of L2 cache) 443891-001

 ● AMD Turion TL-52 (1.6-GHz, 1 MB of L2 cache) 443890-001

 ● Mobile AMD Sempron 3500+ (1.8-GHz, 512 KB of L2 cache) 443915-001

 ● Mobile AMD Sempron 3400+ (1.8-GHz, 256 KB of L2 cache) 443914-001

 Processors for use with HP Compaq 6510b computer models:

 ● Intel Core Duo T7700 2.4-GHz with 4 MB of L2 cache 446894-001

 ● Intel Core Duo T7500 2.2-GHz with 4 MB of L2 cache 446893-001

 ● Intel Core Duo T7300 2.0-GHz with 4 MB of L2 cache 446892-001

 ● Intel Core Duo T7100 1.8-GHz with 2 MB of L2 cache 446891-001

(11) Top cover (includes TouchPad, TouchPad cable, and fingerprint reader) 443921-001

(12) PC Card/audio board assembly 443889-001
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Item Description Spare part number

(13) RTC battery 449137-001

(14) System boards

 For use with HP Compaq 6515b computer models with WWAN capability (includes WWAN
module slot)

443896-001

 For use with HP Compaq 6515b computer models without WWAN capability (does not
include WWAN module slot)

443898-001

 For use with HP Compaq 6510b computer models with WWAN capability (includes WWAN
module slot)

446905-001

 For use with HP Compaq 6510b computer models without WWAN capability (does not
include WWAN module slot)

446904-001

(15) SIM slot board (for use with computer models with WWAN capability) 443907-001

(16) Speaker assembly 443909-001

(17) Modem modules (include modem module cable)

 For use in all countries and regions except Australia and New Zealand 441074-001

 For use only in Australia and New Zealand 441074-011

(18) Media Card Reader/USB connector board 443883-001

(19) Base enclosure (includes 8 rubber feet, not illustrated) 443886-001

(20) Batteries

 6-cell, 2.55-Ah, 55-Wh, Li-ion battery 443885-001

 6-cell, 2.20-Ah, 47-Wh, Li-ion battery 443884-001

(21) Hard drives (include hard drive bracket and connector)

 160-GB, 5400-rpm 443920-001

 120-GB, 5400-rpm 443919-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001

(22) WLAN modules

 802.11a/b/g/n Broadcom WLAN modules for use with all computer models:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the
Virgin Islands

441530-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the Maldives,

441530-002
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Item Description Spare part number

Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe Saudi Arabia, Senegal,
Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 ● For use in Israel and Japan 441530-291

 802.11a/b/g/n Intel WLAN module for use with HP Compaq 6510b computer models:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

441086-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

 ● For use in Japan 441086-291

 802.11a/b/g Broadcom WLAN modules for use with all computer models:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the
Virgin Islands

441075-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia,

441075-002
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Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

 ● For use in Japan 441075-291

 802.11a/b/g Intel WLAN modules for use with HP Compaq 6510b computer models:

 ● For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei,
Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India,
Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia,
Taiwan, the United States, and Vietnam

407575-001

 ● For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the
Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El
Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland,
Ireland, Italy, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain,
Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and Uzbekistan

407575-002

 ● For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru,
Qatar, South Korea, Uruguay, and Venezuela

407575-003

 ● For use in Japan 407575-291

 802.11b/g Broadcom WLAN modules for use with all computer models:  

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the
U.S. Virgin Islands

441090-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-002

 ● For use in Japan 441090-291

 802.11b/g Broadcom WLAN module for use with HP Compaq 6510b computer models in
Japan

409280-004
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(23) Bluetooth modules–Bluetooth module cable not included. This cable is included in the Cable Kit, spare part number
443887-001. See Cable Kit on page 31 for more Cable Kit spare part information.

 For use in all countries and regions except Japan and Asia/Pacific 398393-002

 For use in Japan and Asia/Pacific countries and regions 450066-001

(24) Optical drives (include bezel and optical drive bracket)

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM drive 443902-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit 443905-001

(1) PC Card slot bezel

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)

(3) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(4) Bluetooth module compartment cover (includes 1 captive screw, secured by a C-clip)

(5) Computer feet (4 large, 4 small)

 Display bezel rubber screw covers (6 covers in 2 sizes; not illustrated)
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Cable Kit

Item Description Spare part number

 Cable Kit 443887-001

(1) Modem module cable (includes RJ-11 connector and cable)

(2) Microphone (includes receiver and cable)

(3) Bluetooth module cable
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include frame and connector)

 160-GB, 5400-rpm 443920-001

 120-GB, 5400-rpm 443919-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001

(2) Optical drives (include bezel and optical drive bracket)

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM drive 443902-001
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Miscellaneous parts
Description Spare part number

AC adapters

90-watt PFC AC adapter for use in Africa, Europe, and the Middle East 416421-021

90-watt PFC AC adapter for use in North America 391173-001

Power cords:

Australia 246959-011

Brazil 246959-201

Denmark 246959-081

Europe, the Middle East, and Africa 246959-021

Israel 246959-BB1

Italy 246959-061

Japan 246959-291

Korea 246959-AD1

Switzerland 246959-AG1

The United Kingdom 246959-031

The United States 246959-001

Screw Kit

● Hex HM5.0×9.0 screw lock

● Phillips PM3.0×3.0 screw

● Phillips PM2.5×13.0 captive screw

● Black Phillips PM2.5×8.0 captive screw

● Silver Phillips PM2.5×8.0 captive screw

● Phillips PM2.5×8.0 screw

● Phillips PM2.5×5.0 screw

● Phillips PM2.5×3.0 screw

● Phillips PM2.0×6.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.5×17.0 screw

● Torx T8M2.5×9.0 screw

● Torx T8M2.5×7.0 screw

● Torx T8M2.5×6.0 screw

443906-001

Smart card reader module 443908-001
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Sequential part number listing
Spare part
number

Description

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia

246959-021 Power cord for use in Europe, the Middle East, and Africa

246959-031 Power cord for use in the United Kingdom

246959-061 Power cord for use in Italy

246959-081 Power cord for use in Denmark

246959-201 Power cord for use in Brazil

246959-291 Power cord for use in Japan

246959-AD1 Power cord for use in Korea

246959-AG1 Power cord for use in Switzerland

246959-BB1 Power cord for use in Israel

391173-001 90-watt PFC AC adapter for use in North America

398393-002 Bluetooth module for use in all countries and regions except Japan and Asia/Pacific–Bluetooth module cable
not included. This cable is included in the Cable Kit, spare part number. See Cable Kit on page 31 for more
Cable Kit spare part information.

399440-001 EVDO WWAN module

407575-001 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Antigua and Barbuda,
Argentina, Australia, the Bahamas, Barbados, Brunei, Canada, Chile, the Dominican Republic, Guam,
Guatemala, Hong Kong, India, Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia,
Taiwan, the United States, and Vietnam

407575-002 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Aruba, Austria,
Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman Islands, Colombia, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Italy, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United
Kingdom, and Uzbekistan

407575-003 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Ecuador, Haiti,
Honduras, Pakistan, the People's Republic of China, Peru, Qatar, South Korea, Uruguay, and Venezuela

407575-291 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Japan

409280-004 802.11b/g Broadcom WLAN module for use with HP Compaq 6510b computer models in Thailand

413706-001 Thermal Material Kit for use in all countries and regions except Japan and Asia/Pacific

414045-001 512-MB memory module (667-MHz, PC-5300, 1-DIMM)

414046-001 1024-MB memory module (667-MHz, PC-5300, 1-DIMM)

416421-021 90-watt PFC AC adapter for use in Africa, Europe, and the Middle East

417506-001 2048-MB memory module (667-MHz, PC-5300, 1-DIMM)

430871-001 Mobile AMD Sempron 3400+ 1.8-GHz processor for use with HP Compaq 6515b computer models in all
countries and regions except Japan and Asia/Pacific (256 KB of L2 cache)
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Spare part
number

Description

430872-001 Mobile AMD Sempron 3500+ 1.8-GHz processor for use with HP Compaq 6515b computer models in all
countries and regions except Japan and Asia/Pacific (256 KB of L2 cache)

430874-001 AMD Turion TL-52 1.6-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (1 MB of L2 cache)

430875-001 AMD Turion TL-56 1.8-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (1 MB of L2 cache)

430876-001 AMD Turion TL-60 2.0-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (1 MB of L2 cache)

441074-001 Modem module for use in all countries and regions except Australia and New Zealand (includes modem module
cable)

441074-011 Modem module for use only in Australia and New Zealand (includes modem module cable)

441075-001 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States,
and the Virgin Islands

441075-002 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-291 802.11a/b/g WLAN module for use in Japan

441082-001 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Antigua & Barbuda,
Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia,
Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States,
Uruguay, Venezuela, Vietnam

441082-002 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Austria, Azerbaijan,
Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland,
France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal,
Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri
Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-003 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Australia, New Zealand,
Pakistan, the People's Republic of China, and South Korea

441082-291 802.11a/b/g Intel WLAN module for use with HP Compaq 6510b computer models in Japan

441086-001 802.11a/b/g/n Intel WLAN module for use with HP Compaq 6510b computer models in Antigua and
Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile,
Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras,
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Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-002 802.11a/b/g/n Intel WLAN module for use with HP Compaq 6510b computer models in Austria, Azerbaijan,
Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland,
France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal,
Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri
Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-003 802.11a/b/g/n Intel WLAN module for use in with HP Compaq 6510b computer models in Australia, New
Zealand, Pakistan, the People's Republic of China, and South Korea

441086-291 802.11a/b/g/n Intel WLAN module for use with HP Compaq 6510b computer models in Japan

441090-001 802.11b/g Broadcom WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United
States, and the Virgin Islands

441090-002 802.11b/g Broadcom WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome &
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-291 802.11b/g Broadcom WLAN module for use in Japan

441530-001 802.11b/g Broadcom WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United
States, and the U.S. Virgin Islands

441530-002 802.11b/g Broadcom WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
& Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo,
Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,

36 Chapter 3   Illustrated parts catalog ENWW



Spare part
number

Description

the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441530-291 802.11b/g Broadcom WLAN module for use in Japan

443883-001 Media Card Reader/USB connector board

443884-001 6-cell, 2.20-Ah, 47-Wh battery

443885-001 6-cell, 2.55-Ah, 55-Wh battery

443886-001 Base enclosure (includes 6 rubber feet)

443887-001 Cable Kit

443889-001 PC Card/audio board assembly

443890-001 AMD Turion TL-52 1.6-GHz processor for use with HP Compaq 6515b computer models only in Japan and
Asia/Pacific countries and regions (1 MB of L2 cache)

443891-001 AMD Turion TL-56 1.8-GHz processor for use with HP Compaq 6515b computer models only in Japan and
Asia/Pacific countries and regions (1 MB of L2 cache)

443892-001 AMD Turion TL-64 2.0-GHz processor for use with HP Compaq 6515b computer models only in Japan and
Asia/Pacific countries and regions (1 MB of L2 cache)

443893-001 14.1-inch WXGA display assembly for use only with HP Compaq 6515b computer models without WWAN
capability

443894-001 14.1-inch WXGA, BrightView display assembly for use only with HP Compaq 6515b computer models without
WWAN capability

443895-001 14.1-inch WXGA display assembly for use only with HP Compaq 6515b computer models with WWAN
capability

443896-001 System board for use with HP Compaq 6515b computer models with WWAN capability (includes WWAN
module slot)

443898-001 System board for use with HP Compaq 6515b computer models without WWAN capability (does not include
WWAN module slot)

443901-001 DVD/CD-RW Combo Drive

443902-001 DVD-ROM drive

443903-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

443904-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

443905-001 Plastics Kit (see Plastics Kit on page 30 for more Plastics Kit spare part information)

443906-001 Screw Kit

443907-001 SIM slot board (for use with computer models with WWAN capability)

443908-001 Smart card reader module

443909-001 Speaker assembly

443912-001 Heat sink for use with HP Compaq 6515b computer models (includes thermal material)

443913-001 AMD Turion TL-64 2.2-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (1 MB of L2 cache)

443914-001 Mobile AMD Sempron 3400+ 1.8-GHz processor for use with HP Compaq 6515b computer models in Japan
and Asia/Pacific countries and regions (256 KB of L2 cache)
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443915-001 Mobile AMD Sempron 3500+ 1.8-GHz processor for use with HP Compaq 6515b computer models in Japan
and Asia/Pacific countries and regions (512 KB of L2 cache)

443916-001 Mobile AMD Sempron 3600+ 2.0-GHz processor for use with HP Compaq 6515b computer models in all
countries and regions except Japan and Asia/Pacific (256 KB of L2 cache)

443917-001 Fan

443918-001 80-GB, 5400-rpm hard drive

443919-001 120-GB, 5400-rpm hard drive

443920-001 160-GB, 5400-rpm hard drive

443921-001 Top cover (includes TouchPad, TouchPad cable, and fingerprint reader)

443922-001 Keyboard for use in the United States

443922-031 Keyboard for use in the United Kingdom

443922-041 Keyboard for use in Germany

443922-051 Keyboard for use in France

443922-061 Keyboard for use in Italy

443922-071 Keyboard for use in Spain

443922-081 Keyboard for use in Denmark

443922-091 Keyboard for use in Sweden

443922-121 Keyboard for use in French Canada

443922-131 Keyboard for use in Portugal

443922-141 Keyboard for use in Turkey

443922-161 Keyboard for use in Latin America

443922-171 Keyboard for use in Saudi Arabia

443922-181 Keyboard for use in Belgium

443922-201 Keyboard for use in Brazil

443922-211 Keyboard for use in Hungary

443922-221 Keyboard for use in the Czech Republic

443922-231 Keyboard for use in Slovakia

443922-251 Keyboard for use in Russia

443922-281 Keyboard for use in Thailand

443922-291 Keyboard for use in Japan

443922-A41 Keyboard for use in

443922-AB1 Keyboard for use in Taiwan

443922-AD1 Keyboard for use in Korea

443922-B31 Keyboard for use in the Netherlands
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443922-B71 Keyboard for use in Sweden and Finland

443922-BA1 Keyboard for use in Slovenia

443922-BB1 Keyboard for use in Israel

443922-BG1 Keyboard for use in Switzerland

443922-DD1 Keyboard for use in Iceland

443922-DJ1 Keyboard for use in Greece

445853-001 Thermal Material Kit for use in Japan and Asia/Pacific countries and regions

445939-001 80-GB, 7200-rpm hard drive

446045-001 AMD Turion MK-38 2.2-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (512 KB of L2 cache)

446870-001 Display inverter (includes 2-sided tape)

446891-001 Intel Core Duo T7100 1.8-GHz processor with 2 MB of L2 cache for use with HP Compaq 6510b computer
models

446892-001 Intel Core Duo T7300 2.0-GHz processor with 4 MB of L2 cache for use with HP Compaq 6510b computer
models

446893-001 Intel Core Duo T7500 2.2-GHz processor with 4 MB of L2 cache for use with HP Compaq 6510b computer
models

446894-001 Intel Core Duo T7700 2.4-GHz processor with 4 MB of L2 cache for use with HP Compaq 6510b computer
models

446904-001 System board for use with HP Compaq 6510b computer models without WWAN capability (does not include
WWAN module slot)

446905-001 System board for use with HP Compaq 6510b computer models with WWAN capability (includes WWAN
module slot)

446914-001 14.1-inch, WXGA display panel for use with HP Compaq 6510b computer models without WWAN
capability

446915-001 14.1-inch, WXGA, BrightView display panel for use with HP Compaq 6510b computer models without WWAN
capability

446916-001 14.1-inch, WXGA display panel for use with HP Compaq 6510b computer models with WWAN capability

446920-001 Heat sink for use with HP Compaq 6510b computer models (includes thermal material)

447203-001 Switch cover (includes power button board and cable and LED board and cable)

447204-001 Display left and right hinges

447205-001 Display bezel

448672-002 Vodafone HSPDA WWAN module

448673-002 Cingular HSPDA WWAN module

449137-001 RTC battery

449822-001 14.1-inch, WXGA display assembly for use with HP Compaq 6510b computer models without WWAN
capability

449823-001 14.1-inch, WXGA display assembly for use with HP Compaq 6510b computer models with WWAN capability
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450066-001 Bluetooth module for use in Japan and Asia/Pacific countries and regions–Bluetooth module cable not included.
This cable is included in the Cable Kit, spare part number 443887-001. See Cable Kit on page 31 for more
Cable Kit spare part information.

450067-001 Display enclosure

450939-001 Mobile AMD Sempron 3800+ 2.2-GHz processor for use with HP Compaq 6515b computer models in all
countries and regions except Japan and Asia/Pacific (256 KB of L2 cache)

450940-001 AMD Turion TL-50 1.6-GHz processor for use with HP Compaq 6515b computer models in all countries and
regions except Japan and Asia/Pacific (1 MB of L2 cache)
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Hex 5.0-mm nutdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 v 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 68).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 78 screws and screw locks, in 17 different sizes, that must be removed, replaced,
or loosened when servicing the computer. Make special note of each screw and screw lock size and
location during removal and replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Battery

Description Spare part number

6-cell, 2.55-Ah, 55-Wh, Li-ion battery 443885-001

6-cell, 2.20-Ah, 47-Wh, Li-ion battery 443884-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2).

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the computer.
Be sure the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Display inverter
NOTE: If it has been determined that the display inverter is the component that must be replaced to
complete the computer repair, the display assembly does not have to be removed. Follow the procedures
in this section to replace the display inverter. For information on replacing the display assembly and
display hinges, see Display assembly on page 77.

Description Spare part number

Display inverter (includes 2-sided tape) 446870-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as it will open.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel.

NOTE: The display bezel rubber screw covers are included in the Plastics Kit, spare part number
44305-001.

4. Remove the two Torx T8M2.5×7.0 screws (2) that secure the bottom edge of the display bezel to
the display enclosure.

5. Flex the inside edges of the left and right sides (1) and the bottom edge (2) of the display bezel until
the bezel disengages from the display enclosure.
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6. Release the bottom edge of the display bezel (3) from the display assembly.

7. Release the inverter (1) from the display enclosure as far as the cables attached to it allow.

8. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

9. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Hard drive

Description Spare part number

160-GB, 5400-rpm hard drive 443920-001

120-GB, 5400-rpm hard drive 443919-001

80-GB, 7200-rpm hard drive 445939-001

80-GB, 5400-rpm hard drive 443918-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 screws (1) that secure the hard drive cover to the computer.

3. Lift the left side of the hard drive cover (2), swing it to right, and remove the cover.

NOTE: The hard drive cover is included in the Plastics Kit, spare part number 443905-001.

4. Loosen the Phillips PM2.5×13.0 hard drive retention screw (1) that secures the hard drive to the
computer.

5. Grasp the Mylar tab (2) on the hard drive and pull the hard drive (3) to the right to disconnect it
from the system board.
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6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×3.0 hard drive
bracket screws (1) from each side of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Plastics Kit, spare part
number 443905-001. There are 8 feet in 2 different sizes. The feet attach to the base enclosure in the
locations illustrated below.

Bluetooth module
NOTE: A Bluetooth module cable is not included in the Bluetooth module spare part kit. This cable is
included in the Cable Kit, spare part number 443887-001.

Description Spare part number

For use in all countries and regions except Japan and Asia/Pacific 398393-002

For use in Japan and Asia/Pacific countries and regions 450066-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the Bluetooth® module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 screw (1) that secures the Bluetooth module compartment cover to
the computer.
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3. Lift the rear edge of the cover (2), swing it forward, and remove the cover.

NOTE: The Bluetooth module compartment cover is included in the Plastics Kit, spare part number
443905-001.

4. Remove the Bluetooth module (1) from the computer.

5. Disconnect the Bluetooth module cable (2) from the module.

6. Remove the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.
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Expansion memory module

Description Spare part number

2048-MB, PC2-5300, 1-DIMM memory module 417506-001

1024-MB, PC2-5300, 1-DIMM memory module 414046-001

512-MB, PC2-5300, 1-DIMM memory module 414045-001

Before removing the expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the expansion memory module:

1. Loosen the Phillips PM2.0×5.0 screw (1) that secures the memory/WLAN module compartment
cover to the computer.

2. Lift the rear edge of the cover (2), swing it forward, and remove the cover.

NOTE: The memory/WLAN module compartment cover is included in the Plastics Kit, spare part
number 443905-001.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the expansion memory module.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

802.11a/b/g/n Broadcom WLAN modules for use with all computer models:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the Virgin
Islands

441530-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya,
Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe
Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441530-002

● For use in Israel and Japan 441530-291

802.11a/b/g/n Intel WLAN modules for use with HP Compaq 6510b computer models:

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441086-003

● For use in Japan 441086-291

802.11a/b/g Broadcom WLAN modules for use with all computer models:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the Virgin
Islands

441075-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa

441075-002
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Description Spare part number

Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

● For use in Japan 441075-291

802.11a/b/g Intel WLAN modules for use with HP Compaq 6510b computer models:

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

441082-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441082-003

● For use in Japan 441082-291

802.11a/b/g Intel WLAN modules for use with HP Compaq 6510b computer models:

● For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei, Canada,
Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia, Malaysia,
Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, and
Vietnam

407575-001

● For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman
Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El Salvador, Estonia,
Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy, Jordan, Latvia,
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway,
Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro, Singapore,
Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United
Kingdom, and Uzbekistan

407575-002

● For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru, Qatar, South
Korea, Uruguay, and Venezuela

407575-003

● For use in Japan 407575-291

802.11b/g Broadcom WLAN module for use with all computer models:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the U.S.
Virgin Islands

441090-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441090-002

● For use in Japan 441090-291

802.11b/g Intel WLAN module for use with HP Compaq 6510b computer models in Thailand 409280-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is
connected to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×3.0 screws (3) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel and optical drive bracket.

Description Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

DVD/CD-RW Combo Drive 443901-001

DVD-ROM drive 443902-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

Remove the optical drive:

1. Position the computer with left side toward you.

2. Remove the Torx T8M2.5×9.0 screw (1) that secures the optical drive to the computer.

3. Use a flat-bladed tool to push the metal tab (2) toward the left side of the computer. (The optical
drive is partially ejected from the optical drive bay.)

4. Remove the optical drive (3) from the computer.
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5. If it is necessary to replace the optical drive bracket, remove the two Phillips PM2.0×3.0 screws
(1) that secure the bracket to the optical drive.

6. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Keyboard

Country or region Spare part number Country or region Spare part number

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

International use

Israel

Italy

Japan

Korea

Latin America

443922-181

443922-201

443922-221

443922-081

443922-051

443922-121

443922-041

443922-DJ1

443922-211

443922-DD1

443922-A41

443922-BB1

443922-061

443922-291

443922-AD1

443922-161

The Netherlands

Norway

Portugal

Russia

Saudi Arabia

Spain

Slovakia

Slovenia

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

443922-B31

443922-091

443922-131

443922-251

443922-171

443922-071

443922-231

443922-BA1

443922-B71

443922-BG1

443922-AB1

443922-281

443922-141

443922-031

443922-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

Remove the keyboard:

1. Position the computer with the front toward you.
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2. Loosen the three Phillips PM2.5×8.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.

6. Lift the rear edge of the keyboard (2) and swing it toward you until it rests on the palm rest.
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Internal memory module

Description Spare part number

2048-MB, 667-MHz, PC-5300, 1-DIMM memory module 417506-001

1024-MB, 667-MHz, 1-DIMM memory module 414046-001

512-MB, 667-MHz, 1-DIMM memory module 414045-001

Before removing the internal memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

6. Release the keyboard (see Keyboard on page 64).

Remove the internal memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the internal memory module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

6. Release the keyboard (see Keyboard on page 64).

Remove the RTC battery:

� Use a non-conductive, flat-bladed tool to pry the RTC battery out of the socket.

Reverse this procedure to install the RTC battery. Be sure the RTC battery is installed with the “+” sign
facing up.

68 Chapter 4   Removal and replacement procedures ENWW



WWAN module
CAUTION: The WWAN module and WLAN module are not interchangeable.

Description Spare part number

EVDO WWAN module for use in all countries and regions except Japan and Asia/Pacific 399440-001

Vodafone HSPDA WWAN module 448672-002

Cingular HSPDA WWAN module 448673-002

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

6. Release the keyboard (see Keyboard on page 64).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal. If the computer is
equipped with an HSPDA WWAN module, the red WWAN antenna cable is connected to the only
terminal on the module.

2. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure to install the WWAN module.

Switch cover

Description Spare part number

Switch cover (includes power button board and cable and LED board and cable) 447203-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the keyboard (see Keyboard on page 64).

Remove the switch cover:

1. Release the ZIF connector (1) to which the LED board cable is attached and disconnect the LED board
cable (2) from the system board.
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2. Insert a flat-bladed tool into one of the four slots (3) in the switch cover and lift the switch cover
(4) until it disengages from the computer.

3. Remove the switch cover.

Reverse this procedure to install the switch cover.

Fan

Description Spare part number

Fan 443917-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the keyboard (see Keyboard on page 64).

6. Remove the switch cover (see Switch cover on page 70).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

NOTE: The illustration below shows the fan removal steps for the HP Compaq 6515b computer
model. The fan cable on the HP Compaq 6510b computer model is in a different location, but the
disconnection steps are the same.

2. Loosen the Phillips PM2.5×8.0 captive screw (2) that secures the fan to the computer.
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3. Remove the Phillips PM2.5×8.0 screw (3) that secures the fan to the computer.

4. Remove the fan (4).

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software applications. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Heat sink
NOTE: All heat sink spare part kits include thermal material.

Description Spare part number

For use with HP Compaq 6515b computer models 443912-001

For use with HP Compaq 6510b computer models 446920-001

Thermal Material Kit for use in all countries and regions except Japan and Asia/Pacific 413706-001

Thermal Material Kit for use in Japan and Asia/Pacific countries and regions 445853-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the keyboard (see Keyboard on page 64).

6. Remove the switch cover (see Switch cover on page 70).

7. Remove the fan (see Fan on page 71).

Remove the heat sink:

1. Remove the four Phillips PM2.0×6.0 screws (1) that secure the heat sink to the system board.

2. Release the heat sink (2) by lifting the right side until it disengages from the processor.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
processor, it may be necessary to move the heat sink from side to side to detach the heat sink from
the processor.
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3. Remove the heat sink (3) by swinging it counterclockwise until the left side of the heat sink clears the
top cover.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
the processor and system board components (2) each time the heat sink is removed. Thermal material
is included with all heat sink and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include thermal material.

Description Spare part number

Processors for use with HP Compaq 6515b computer models in all countries and regions except Japan and Asia/Pacific:

● AMD Turion TL-64, 2.2-GHz processor (1 MB of L2 cache) 443913-001

● AMD Turion MK-38, 2.2-GHz processor (512 KB of L2 cache) 446045-001

● AMD Turion TL-60, 2.0-GHz processor (1 MB of L2 cache) 430876-001

● AMD Turion TL-56, 1.8-GHz processor (1 MB of L2 cache) 430875-001

● AMD Turion TL-52, 1.6-GHz processor (1 MB of L2 cache) 430874-001

● AMD Turion TL-50, 1.6-GHz processor (1 MB of L2 cache) 450940-001

● Mobile AMD Sempron 3800+ 2.2-GHz processor (256 KB of L2 cache) 450939-001

● Mobile AMD Sempron 3600+ 2.0-GHz processor (256 KB of L2 cache) 443916-001

● Mobile AMD Sempron 3500+ 1.8-GHz processor (512 KB of L2 cache) 430872-001

● Mobile AMD Sempron 3400+ 1.8-GHz processor (256 KB of L2 cache) 430871-001

Processors for use with HP Compaq 6515b computer models only in Japan and Asia/Pacific countries and regions:

● AMD Turion TL-60, 2.0-GHz processor (1 MB of L2 cache) 443892-001

● AMD Turion TL-56, 1.8-GHz processor (1 MB of L2 cache) 443891-001

● AMD Turion TL-52, 1.6-GHz processor (1 MB of L2 cache) 443890-001

● Mobile AMD Sempron 3500+ 1.8-GHz processor (512 KB of L2 cache) 443915-001

● Mobile AMD Sempron 3400+ 1.8-GHz processor (256 KB of L2 cache) 443914-001

Processors for use with HP Compaq 6510b computer models

● Intel Core Duo T7700 2.4-GHz with 4 MB of L2 cache 446894-001

● Intel Core Duo T7500 2.2-GHz with 4 MB of L2 cache 446893-001

● Intel Core Duo T7300 2.0-GHz with 4 MB of L2 cache 446892-001

● Intel Core Duo T7100 1.8-GHz with 2 MB of L2 cache 446891-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Release the keyboard (see Keyboard on page 64).

ENWW Component replacement procedures 75



6. Remove the switch cover (see Switch cover on page 70).

7. Remove the fan (see Fan on page 71).

8. Remove the heat sink (see Heat sink on page 73).

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed on
the processor socket when you install the processor. The illustration below shows the processor
removal steps for the HP Compaq 6515b computer model.

NOTE: The illustration below shows the processor removal steps for the HP Compaq 6510b
computer model.

Reverse this procedure to install the processor.
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Display assembly

Description Spare part number

14.1-inch, WXGA+ display assembly for use only with HP Compaq 6515b computer models with
WWAN capability

443895-001

14.1-inch, WXGA+, BrightView display assembly for use only with HP Compaq 6515b computer
models without WWAN capability

443894-001

14.1-inch, WXGA+ display assembly for use only with HP Compaq 6515b computer models without
WWAN capability

443893-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 56).

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 58).

7. Remove the following components:

a. Keyboard (see Keyboard on page 64)

b. Switch cover (see Switch cover on page 70)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.

2. Remove the wireless antenna cables (2) from the routing channels and clips built into the top cover.

ENWW Component replacement procedures 77



3. Remove the Torx T8M2.5×17.0 screw (1) and the Torx T8M2.5×7.0 screw (2) that secure the
display assembly to the computer.

4. Position the computer with the rear panel toward you.

5. Remove the four Torx T8M2.5×9.0 screws (1) that secure the display assembly to the computer.
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6. Lift the display assembly straight up and remove it (2).

CAUTION: When installing the display assembly, be sure that the wireless antenna cables routed
out of the display assembly right hinge are routed and arranged properly. Each antenna cable has
an exposed section of cable (1) and a metallic grounding sleeve (2). The grounding sleeve must
completely cover the exposed section of cable. Each cable must be secured inside a space in the
copper grounding clip (3). Left to right, the cables must be installed in a red, white, black, blue
sequence.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
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7. If it is necessary to replace the display hinges, remove the following:

(1) Four rubber screw covers from the display bezel top edge

NOTE: The display bezel rubber screw covers are included in the Plastics Kit, spare part number
44305-001.

(2) Four Torx T8M2.5×6.0 screws from the display bezel top edge

(3) Two rubber screw covers from the display bezel bottom edge

(4) Two Torx T8M2.5×7.0 screws from the display bezel top edge

8. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

9. Remove the display bezel (3).

NOTE: The display bezel is available using spare part number 447205-001.
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10. Remove the six Torx T8M2.5×6.0 screws (1) that secure the display panel to the display
enclosure.

11. Remove the display panel (2).

12. Remove the four Phillips PM2.0×3.0 screws (1) that secure each display hinge to the display panel.

13. Remove the display hinges (2).

NOTE: The left and right display hinges are available using spare part number 447204-001.

Reverse this procedure to install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad, TouchPad cable, and fingerprint reader) 443921-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Display assembly (see Display assembly on page 77)

Remove the top cover:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the two rubber screw covers (1) on the front edge of the computer.

NOTE: The base enclosure rubber screw covers are included in the Plastics Kit, spare part number
44305-001.

3. Remove the eleven Torx T8M2.5×9.0 screws (2) that secure the top cover to the computer.
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4. Remove the two HM5.0×9.0 screw locks (3) that secure the top cover to the computer.

5. Turn the computer right-side up, with the front toward you.

6. Disconnect the TouchPad cable (1) and the fingerprint reader board cable (2) from the system board.

7. Remove the microphone (3) from the clip built into the top cover and remove the microphone cable
from the clips built into the top cover.
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8. Remove the two Torx T8M2.5×9.0 screws that secure the top cover to the computer.

9. Lift the rear edge of the top cover (1) until it disengages from the base enclosure.

10. Swing the rear edge of the top cover (2) toward you until it rests at an angle.

11. Remove the top cover (3) by lifting it straight up.

12. If it is necessary to replace the microphone and cable, disconnect the microphone cable (1) from
the PC Card/audio board and remove it.

NOTE: The microphone is available in the Cable Kit, spare part number 443887-001.
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13. If it is necessary to replace the Bluetooth module cable, disconnect the cable (2) from the system
board and remove the cable from the opening (3) in the base enclosure.

NOTE: The Bluetooth module cable is available in the Cable Kit, spare part number 443887-001.

14. If it is necessary to replace the modem module cable, disconnect the cable (1) from the modem
module and the system board (2), and remove the modem connector (3) from the clip built into the
base enclosure.

NOTE: The modem module cable is available in the Cable Kit, spare part number 443887-001.

Reverse this procedure to install the top cover, microphone, Bluetooth module cable, and modem module
cable.

Speaker assembly

Description Spare part number

Speaker assembly 443909-001
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Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Display assembly (see Display assembly on page 77)

g. Top cover (see Top cover on page 82)

Remove the speaker assembly:

1. Disconnect the speaker assembly cable (1) from the PC Card/audio board assembly.

2. Remove the two Phillips PM2.5×5.0 screws (2) and the Phillips PM2.0×3.0 screw (3) that secure
the speaker assembly to the base enclosure.

3. Remove the speaker assembly (4).

Reverse this procedure to install the speaker assembly.
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Media Card Reader/USB connector board
NOTE: The Media Card Reader/USB connector board includes a Media Card Reader/USB connector
board cable.

Description Spare part number

Media Card Reader/USB connector board 443883-001

Before removing the Media Card Reader/USB connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Display assembly (see Display assembly on page 77)

g. Top cover (see Top cover on page 82)

Remove the Media Card Reader/USB connector board:

1. Disconnect the Media Card Reader/USB connector board cable (1) from the system board.

2. Remove the two Phillips PM2.5×5.0 screws (2) that secure the Media Card Reader/USB connector
board to the computer.
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3. Lift the Media Card Reader/USB connector board (3) straight up and remove it.

Reverse this procedure to install the Media Card Reader/USB connector board.
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System board

Description Spare part number

For use with HP Compaq 6515b computer models with WWAN capability (includes WWAN module
slot)

443896-001

For use with HP Compaq 6515b computer models without WWAN capability (does not include
WWAN module slot)

443898-001

For use with HP Compaq 6510b computer models with WWAN capability (includes WWAN module
slot)

446905-001

For use with HP Compaq 6510b computer models without WWAN capability (does not include
WWAN module slot)

446904-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Fan (see Fan on page 71)

g. Heat sink (see Heat sink on page 73)

h. Display assembly (see Display assembly on page 77)

i. Top cover (see Top cover on page 82)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● SIM (see SIM on page 49)

● Memory modules (see Expansion memory module on page 56) and Internal memory module
on page 67)

● WLAN module (see WLAN module on page 58)

● RTC battery (see RTC battery on page 68)
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● WWAN module (see WWAN module on page 69)

● Processor (see Processor on page 75)

● PC Card/audio board assembly (see PC Card/audio board assembly on page 92)

● Modem module (see Modem module on page 93)

● SIM slot board (see SIM slot board on page 95)

Remove the system board:

1. Press the PC Card eject button (1) twice. The first press releases the PC Card eject button from the
PC Card slot. The second press releases the PC Card slot bezel from the PC Card slot. (The PC Card
slot bezel is partially ejected from the PC Card slot.)

2. Remove the PC Card slot bezel (2) from the PC Card slot.

NOTE: The PC Card slot bezel is included in the Plastics Kit, spare part number 443905-001.

3. Disconnect the Media Card Reader/USB connector board cable (3) from the system board.

4. Remove the three Phillips PM2.5×5.0 screws (1) that secure the system board to the top cover.

NOTE: If the computer is equipped with a WWAN module, an additional Phillips PM2.5×5.0
screw (2) must be removed.
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5. Use the optical drive connector (1) to lift the right side of the system board (2) until the rear left
corner of the system board (3) clears the base enclosure.

6. Remove the system board (4) by pulling it away from the top cover at an angle until it clears the top
cover

Reverse the preceding procedure to install the system board.
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PC Card/audio board assembly

Description Spare part number

PC Card/audio board assembly 443889-001

Before removing the PC Card/audio board assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Fan (see Fan on page 71)

g. Heat sink (see Heat sink on page 73)

h. Display assembly (see Display assembly on page 77)

i. Top cover (see Top cover on page 82)

j. System board (see System board on page 89)

Remove the PC Card/audio board assembly:

1. Remove the Phillips PM2.5×5.0 screw (1) that secures the PC Card/audio board assembly to the
system board.

2. Lift the left side of the PC Card/audio board assembly (2) until it disengages from the system board.
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3. Remove the PC Card/audio board assembly (3) by pulling it away from the system board at an
angle.

Reverse this procedure to install the PC Card/audio board assembly.

Modem module
NOTE: The modem module spare part kits include a modem module cable.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 441074-001

For use only in Australia and New Zealand 441074-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Fan (see Fan on page 71)
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g. Heat sink (see Heat sink on page 73)

h. Display assembly (see Display assembly on page 77)

i. Top cover (see Top cover on page 82)

j. System board (see System board on page 89)

k. PC Card/audio board assembly (see PC Card/audio board assembly on page 92)

Remove the modem module:

1. Turn the PC Card/audio board assembly upside down.

2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the modem module to the PC Card/audio
board assembly.

3. Lift the modem module (2) straight up and remove it.

Reverse this procedure to install the modem module.
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SIM slot board
NOTE: This section applies only to computer models with WWAN capability.

Description Spare part number

SIM slot board 443907-001

Before removing the SIM slot board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 56)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Switch cover (see Switch cover on page 70)

f. Fan (see Fan on page 71)

g. Heat sink (see Heat sink on page 73)

h. Display assembly (see Display assembly on page 77)

i. Top cover (see Top cover on page 82)

j. System board (see System board on page 89)

Remove the SIM slot board:

1. Turn the system board right-side up, with the front toward you.
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2. Lift the SIM slot board (1) straight up and remove it, making note of the location of the pins (2) on
the SIM slot board and their alignment with the system board.

Reverse this procedure to install the SIM slot board.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is
not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows opens and while the “F10=ROM Based Setup” message is displayed in the lower-
left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you restore
the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup by
turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions available
in Embedded Security for ProtectTools. For more information, refer to the
ProtectTools Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase cycles
from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.
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Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system or on any optional
MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.

System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette drive,
or optical drive connected by a USB port to the computer or to an optional
docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code execution,
which helps to improve computer security.
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Select To do this

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Height (front to back) 3.39 to 3.95 cm 1.32 to 1.56 in

Width 33.1 cm 13.03 in

Depth 24.3 cm 9.57 in

Weight (with optical drive, hard drive, and battery) 2.44 kg 5.38 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min
sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min
sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA+ display specifications
 Metric U.S.

Dimensions

Height 21.3 cm 8.40 in

Width 28.5 cm 11.20 in

Diagonal 35.8 cm 14.10 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1440 × 900

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.5.0 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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Hard drive specifications
 160-GB* 120-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 312,560,640 234,420,480 156,280,320

Disc rotational speed 5400 rpm 5400 rpm 7200 and 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications
may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Primary 6-cell, Li-ion battery specifications
 Metric U.S.

Dimensions

Height 2.0 cm 0.79 in

Width 20.3 cm 7.99 in

Depth 5.3 cm 2.09 in

Weight 0.34 kg 0.75 lb

Energy

Voltage 14.4 V

Amp-hour capacity 2.2 Ah and 2.55 Ah

Watt-hour capacity 47 Wh and 55Wh

Temperature

Operating 5°C to 45°C 41°F to 113°F

Nonoperating 0°C to 60°C 32°F to 140°F
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DVD±RW and CD-RW Super Multi Double-Layer
Combo Drive specifications

 Read: Write:

Applicable disc CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD
+R, DVD+RW, DVD-RAM

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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DVD/CD-RW Combo Drive specifications
 Read: Write:

Applicable disc CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD
+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment audio
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I/O address (hex) System function (shipping configuration)

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part number
443906-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.0mm 5.0 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover by C-
clips)

(2) One screw that secures the Bluetooth module compartment cover to the computer (screw is captured
on the cover by a C-clip)

(3) One screw that secures the memory/WLAN module compartment cover to the computer (screw is
captured on the cover by a C-clip)
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Phillips PM2.5×13.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 13.0 mm 2.5 mm 6.0 mm

Where used: One screw that secures the hard drive to the computer
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Phillips PM3.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 4 3.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×3.0 screw

Color Quantity Length Thread Head diameter

Black 6 3.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the computer
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Where used: 2 screws that secure the WWAN module to the computer

Where used: 2 screws that secure the modem module to the PC Card/audio board assembly
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Torx T8M2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 18 9.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Four screws that secure the display assembly to the computer
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Where used: 11 screws that secure the top cover to the computer

Where used: 2 screws that secure the top cover to the computer
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 11 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Where used: 8 screws that secure the display hinges to the display panel

Where used: One screw that secures the speaker assembly to the computer
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Black Phillips PM2.5×8.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 8.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the keyboard to the computer
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Torx T8M2.5×17.0 screw

Color Quantity Length Thread Head diameter

Black 1 17.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display assembly left hinge to the computer
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Torx T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 3 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display assembly right hinge to the computer

Where used: 2 screws that secure the bottom edge of the display bezel to the display assembly
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Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 10 6.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the top edge of the display bezel to the display enclosure
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Where used: 6 screws that secure the display panel to the display enclosure

Hex HM5.0×9.0 screw lock

Color Quantity Length Thread Head diameter

Silver 2 9.0 mm 2.5 mm 5.0 mm

Where used: 2 screw locks that secure the top cover to the computer
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Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the speaker assembly to the base enclosure

(2) Two screws that secure the Media Card Reader/USB connector board to the base enclosure
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Where used:

(1) Three screws that secure the system board and the PC Card/audio board assembly to the base
enclosure

(2) One screw that secures the SIM slot board to the system board

(3) One screw that secures the PC Card/audio board assembly to the system board
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Silver Phillips PM2.5×8.0 captive screw

Color Quantity Length Thread Head diameter

Silver 1 8.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the fan to the computer
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Phillips PM2.5×8.0 screw

Color Quantity Length Thread Head diameter

Silver 1 8.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the fan to the computer
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Heat width

Silver 4 6.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the heat sink to the computer
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8 Backup and recovery in
Windows Vista

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R media (purchased separately).

NOTE: Formatted DVD±RW discs and DVD±RW double-layer discs are not compatible with HP
Backup & Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally
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NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your full
factory image if you experience system failure or instability. HP Backup & Recovery Manager works
from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Backup and recovery in
Windows XP

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R media (purchased separately).

NOTE: Formatted DVD±RW discs and DVD±RW double-layer discs are not compatible with HP
Backup and Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the
system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy them
to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.
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HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

144 Chapter 9   Backup and recovery in Windows XP ENWW



Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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10 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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S-Video-out

Pin Signal

1 S-VHS color (C) signal

2 Composite video signal

3 S-VHS intensity (Y) signal

4 S-VHS color ground

5 TV-CD

6 S-VHS intensity ground

7 Composite video ground

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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11 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries or regions
The requirements listed below are applicable to all countries or regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by each country or region's power system.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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12 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

154 Chapter 12   Recycling ENWW



4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port 17

A
AC adapter, spare part

numbers 33,  34
accessory battery connector 19
antennae, disconnecting 60,  69
applications key, Windows 14
audio, product description 2,  7
audio-in jack

location 17
pin assignments 147

audio-out jack
location 17
pin assignments 147

B
backing up 136,  142
backup

files and folders 137,  143
hard drive 137,  143
modifications made to the

system 137,  143
scheduling 138,  144

base enclosure, spare part
number 26,  37

battery
location 19
removal 48
spare part numbers 26,  37, 

48
specifications 106

battery bay 19
battery light 13,  16
battery release latch 19
bezel

removal 80
spare part number 80

Bluetooth module
removal 54
spare part numbers 29,  34, 

40,  54
Bluetooth module cable

illustrated 31
removal 85

Bluetooth module compartment 19
Bluetooth module compartment

cover
illustrated 30
removal 55

boot options 101
boot order 101
bottom components 19
buttons

info 12
PC Card eject 17
power 11
presentation 12
volume mute 12
wireless 12

C
Cable Kit

contents 31
spare part number 24,  31, 

37
cables, service considerations 42
caps lock light 13
chipset, product description 1,  5
CMOS clearing 46
components

bottom 19
buttons 11
fingerprint reader 11
front 16
keys 14
left-side 17
lights 13

pointing device 15
rear 18
right-side 18
switches 11
top 11
TouchPad 15

computer feet
illustrated 30
locations 54

Computer Setup
accessing 97
Diagnostics menu 101
File menu 99
navigating and selecting 98
restoring factory settings 98
Security menu 100
System Configuration

menu 101
using 98

computer specifications 103
connectors

accessory battery 19
docking 19
service considerations 42

creating recovery points 137, 
143

D
Diagnostics menu 101
Disk Sanitizer 100
diskette drive

precautions 42
product description 2,  6

display assembly
removal 77
spare part numbers 23,  37, 

39,  77
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display bezel
removal 80
spare part number 23,  39, 

80
display component recycling 153
display enclosure, spare part

number 23,  40
display hinge

removal 80
spare part number 23,  39, 

81
display inverter

removal 50
spare part number 23,  39, 

50
display panel

removal 81
spare part numbers 23,  39

display release latch 16
display specifications 104
display switch 12
docking connector 19
docking support, product

description 4,  8
drive light 14,  16
DriveLock password 100
drives

boot order 101
preventing damage 42

DVD-ROM drive
location 18
precautions 42
removal 62
spare part number 29,  32, 

37,  62
specifications 109

DVD/CD-RW Combo Drive
location 18
precautions 42
removal 62
spare part number 29,  32, 

37,  62
specifications 108

DVD±RW and CD-RW Combo Drive
location 18
precautions 42
removal 62
spare part numbers 29,  32, 

37,  62
specifications 107

E
electrostatic discharge 43
Ethernet, product description 3,  7
Execution Disable 101
external media cards, product

description 3,  7
external monitor port

location 18
pin assignments 148

F
fan

removal 71
spare part number 24,  38, 

71
feet

illustrated 30
locations 54

File menu 99
fingerprint reader 12
front components 16
function keys 14

G
graphics, product description 1, 

5
grounding equipment and

methods 45

H
hard drive

location 19
precautions 42
product description 2,  6
removal 52
spare part numbers 26,  32, 

38,  39,  52
specifications 105

hard drive backup 137,  143
hard drive bay 19
hard drive bracket, removal 53
hard drive cover

illustrated 30
removal 52

hard drive recovery 139,  145
hard drive test 101
headphone jack

location 17
pin assignments 147

heat sink
removal 73
spare part numbers 24,  37, 

39,  73
hinge

removal 80
spare part number 23,  39, 

81

I
I/O address specifications 112
info button 12
interrupt specifications 111
inverter

removal 50
spare part number 23,  39, 

50

J
jacks

audio-in 17
audio-out 17
headphone 17
microphone 17
modem 18
network 18
RJ-11 18
RJ-45 18
S-Video-out 18

K
keyboard

product description 4,  8
removal 64
spare part numbers 23,  38, 

64
keypad keys 14
keys

esc 14
fn 14
function 14
Windows applications 14
Windows logo 14

L
LAN Power Save 102
language, changing in Computer

Setup 101
left-side components 17
legacy support, USB 97,  101
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lights
battery 13,  16
caps lock 13
drive 14,  16
num lock 13
power 13,  16
volume down 13
volume mute 13
volume up 13
wireless 13,  16

M
mass storage devices, spare part

numbers 32
Media Card Reader 18
Media Card Reader/USB connector

board
removal 87
spare part number 26,  37, 

87
memory check 101
memory map specifications 114
memory module

product description 1,  6
removal 56,  67
spare part numbers 24,  34, 

56,  67
memory/WLAN module

compartment 19
memory/WLAN module

compartment cover
illustrated 30
removal 56

microphone
illustrated 31
removal 84

microphone jack
location 17
pin assignments 147

modem jack
location 18
pin assignments 149

modem module
product description 3,  7
removal 93
spare part numbers 26,  35, 

93
modem module cable

illustrated 31
removal 85

monitor port
location 18
pin assignments 148

N
navigating in Computer Setup 98
network jack

location 18
pin assignments 149

num lock light 13

O
operating system, product

description 4,  9
optical drive

location 18
precautions 42
product description 2,  6
removal 62
spare part numbers 29,  32, 

37,  62
specifications 107,  108, 

109
optical drive bracket, removal 63

P
packing guidelines 44
panels, product description 1,  5
parallel port mode 101
password clearing 46
passwords 100
PC Card eject button 17
PC Card slot 17
PC Card slot bezel, illustrated 30
PC Card/audio board assembly

removal 92
spare part number 25,  37, 

92
pin assignments

audio-in jack 147
audio-out jack 147
external monitor port 148
headphone jack 147
microphone jack 147
modem jack 149
monitor port 148
network jack 149
RJ-11 149
RJ-45 jack 149

S-Video-out jack 150
Universal Serial Bus (USB)

port 150
plastic parts 41
Plastics Kit

contents 30
spare part number 25,  30, 

37
pointing device

components 15
product description 4

pointing devices, product
description 8

ports
1394 17
external monitor 18
monitor 18
product description 3,  7
Universal Serial Bus (USB) 17, 

18
power button 11
power connector 17
power cord

set requirements 151
spare part numbers 33,  34

power light 13,  16
power requirements, product

description 4,  8
power-on password 100
presentation button 12
processor

product description 1,  5
removal 75
spare part numbers 25,  34, 

37,  39,  40,  75
product description

audio 2,  7
chipset 1,  5
diskette drive 2,  6
docking support 4,  8
Ethernet 3,  7
external media cards 3,  7
graphics 1,  5
hard drives 2,  6
keyboard 4,  8
memory module 1,  6
modem module 3,  7
operating system 4,  9
optical drives 2,  6
panels 1,  5
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pointing devices 4,  8
ports 3,  7
power requirements 4,  8
processors 1,  5
security 4,  8
serviceability 5,  9
wireless 3,  7

R
rear components 18
recovery discs

creating 135,  141
using 139,  145

recovery partition 140,  146
recovery points 137,  143
removal/replacement

preliminaries 41
procedures 47

restoring Computer Setup factory
settings 98

right-side components 18
RJ-11 jack

location 18
pin assignments 149

RJ-45 jack
location 18
pin assignments 149

RTC battery
removal 68
spare part number 26,  39, 

68

S
S-Video-out jack

location 18
pin assignments 150

scheduling backups 138,  144
Screw Kit

contents 115
spare part number 33,  37

screw listing 115
security cable slot 18
Security menu 100
security, product description 4,  8
selecting in the Computer

Setup 98
serial number 21,  47
service considerations 41
serviceability, product

description 5,  9

SIM slot board
removal 95
spare part number 26,  37, 

95
SIM, removal 49
Smart card reader module, spare

part number 33,  37
smart card security 100
speaker assembly

removal 85
spare part number 26,  37, 

85
speakers 16
specifications

battery 106
computer 103
display 104
DVD-ROM drive 109
DVD/CD-RW Combo

Drive 108
DVD±RW and CD-RW Combo

Drive 107
hard drive 105
I/O addresses 112
interrupts 111
memory map 114
optical drive 107,  108,  109
system DMA 110

startup check 101
static-shielding materials 45
stringent security 100
switch cover

removal 70
spare part number 23,  39, 

70
system backup 137,  143
system board

removal 89
spare part numbers 26,  37, 

39,  89
System Configuration menu 101
system DMA 110
system fan 101
system information 99
system memory map 114
system recovery points 137,  143

T
Thermal Material Kit, spare part

numbers 24,  34,  39,  73

thermal material, replacement 74
tools required 41
top components 11
top cover

removal 82
spare part number 25,  38, 

82
TouchPad 15
TouchPad button 15
TouchPad components 15
TouchPad scroll zone 15
transporting guidelines 44

U
Universal Serial Bus (USB) port

location 17,  18
pin assignments 150

unknown password 46
USB legacy support 97,  101

V
vents 17,  19
volume down light 13
volume mute button 12
volume mute light 13
volume scroll zone 12
volume up light 13

W
Windows applications key 14
Windows logo key 14
wireless antennae,

disconnecting 60,  69
wireless button 12
wireless light 13,  16
wireless, product description 3,  7
WLAN module

removal 58
spare part numbers 26,  34, 

35,  36,  58
workstation guidelines 44
WWAN module

removal 69
spare part numbers 24,  34, 

39,  69
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